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Setup Guide

After you finish reading this guide, store it in a safe place for future reference. 
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 How This Manual Is Organized 

•  As we are constantly improving our products, if you need an exact specification, please contact Canon. 

•  Screen shots used in this manual may differ from the ones you actually see. 

 Chapter 1 

 Operations Required to Use the Machine 
 Describes the initial settings required, such as logging in to the machine, and connecting to a network. 

 Chapter 2 

 Starting to Use the Various Functions of the Machine 
 Uses general examples to describe the setup required before using the functions of the machine. 

 Chapter 3 

 Using the System Options/MEAP Applications 
 Describes the procedure for installing system options and MEAP applications using the Register/Update 
Software function, and the procedure for using system options and MEAP applications. 
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 Preface 
 It is necessary to specify settings in advance to use some functions of the machine. Refer to “Flow of Settings for Using 
the Desired Functions,” on p. 4 in this manual to check the flow of the required operations. 
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 Symbols Used in This Manual 
 The following symbols are used in this manual to explain procedures, restrictions, handling precautions, and instructions that should 
be observed for safety. 

Indicates operational requirements and restrictions. Be sure to read these items carefully to 
operate the machine correctly, and avoid damage to the machine or property.

Indicates a clarification of an operation, or contains additional explanations for a procedure. 
Reading these notes is highly recommended.

 Keys and Buttons Used in This Manual 
 The following key and button names are a few examples of how keys to press and buttons to click are expressed in this manual: 

- Touch Panel Display Keys: [Key Name] - Buttons on Computer Operation Screens: [Button Name]

Examples: [Cancel]/[Close] Examples: [OK]/[Add]

- Control Panel Keys: Key Icon (Key Name)

Examples: (Start)/ (Stop)
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● The optional FAX Board is required.

These functions can 
be used by default 
(no settings are 
required).

Fax
(Receive on the Machine)

Register/Update 
Software*3

Scan and Store*1/ 
Access Stored Files*1*2 

(Mail Box/Memory 
Media)

Copy

Scanner

Scan and Send*4

Scan and Store / 
Access Stored

Files
(Advanced Box/Network)

Remote UI

MEAP

Print*4

Fax 
(Sending/Receiving)

● The optional FAX Board is required.

● The optional FAX Board is required.

● The optional Remote Fax Kit and license registration are required.

● An optional product(s) and/or license registration may be required, depending on the print function.

● Connecting to a Network

● Connecting via a USB

See e-Manual.

● Connecting to a Network

Sending and Receiving Documents 

via the Remote Fax Server

Sending Faxes from a Computer 

via the Machine*4

Using an Advanced Box on 

the Network*1

Sending  Faxes from the Machine*4

Sending to a File Server

Sending by E-Mail/I-Fax

   Flow of Settings for Using the Desired Functions 
 This flowchart indicates the flow of settings required for using each function of the machine. After checking the flow of 
settings required, refer to the detailed page in this manual or the e-Manual to perform the actual setting procedure. 

 First, refer to “Logging In 
as an Administrator,” on 
p. 10.  

 See “Network Settings,” 

on p. 14. 

 See “Network Settings,” 

on p. 14. 
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● Using TCP/IP:

● Network Settings
* These settings are only required when connecting to a network. 
 They are not required when connecting via USB.

See e-Manual.

See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:

● Using TCP/IP:

● Remote Scan Settings

● Settings for Printing from a Computer

● Remote UI Settings

● Using an Advanced Box on the Network

● Fax Settings

● Settings for Fax from a Computer

● Remote Fax Settings

● E-Mail/ I-Fax Settings

See e-Manual.

● Using TCP/IP:

● Using SMB/CIFS:

● Setting Up a Computer as a File Server*5

*1  You can print PDF files stored in advanced box, memory media or the Advanced Box of another machine on the network. To perform printing, the PS Printer Kit or Direct Print Kit 

(for PDF/XPS) is required. (Both the PS Printer Kit and Direct Print Kit (for PDF/XPS) require license registration.) 

*2 The default setting for displaying memory media is 'OFF'. To use the memory media, press [Display Settings] in [Preferences] (Settings/Registration) → press [Store Location 

Display Settings] → [Memory Media] → [On].  

*3 To access a distribution server to register/update software, it is necessary to perform the "Connecting to a Network" and "Network Settings" operations indicated in this flowchart. 

To register/update software using the Remote UI, it is necessary to perform the "Connecting to a Network," "Network Settings," and "Remote UI Settings" operations. 

*4 For information on the system requirements, see e-Manual > Optional Products/Software . 

*5 The file servers you can use depend on your network. For details on the file servers you can use, see e-Manual > Network.

● Using SMB/CIFS:
● Using AppleTalk:
● Using Netware:

● MEAP Service Management Service 
(SMS) Settings

 

 See “Sending/Receiving Faxes via the 

Remote Fax Server,” on p. 45. 

 See “Sending Faxes,” on p. 40. 

 See “Sending from a Computer,” on p. 52. 

 See “Printing from a Computer,” on p. 67. 

 See “Storing Data in the Machine, 
Memory Media, Etc.,” on p. 58. 

 See “Sending to a Computer,” on p. 33. 

 See “Sending E-Mail/I-Faxes,” on p. 29. 

 See “Managing by Using the Remote UI,” 
on p. 22. 

 See “Managing Applications Using SMS,” 

on p. 23. 

 See “Storing Data in a Computer,” on p. 55. 

 See “Setting an IP Address,” on p. 17. 

 See “Setting an IP Address,” on p. 17. 

 See “Setting an IP Address,” on p. 17. 
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   Logging In as an Administrator 

 To specify the settings, you must log in to the machine as an administrator. There are two methods for logging in; logging in 
from the touch panel display of the machine and logging in from a computer using the Remote UI. 

 

Computer

Network

Touch Panel Display

Remote UI

This Machine

Enter the System Manager ID and PIN in 

[System Manager ID] and [System PIN] from the 

touch panel display of the machine to log in as 

an administrator.

The Remote UI is software that enables you 

to access the machine from your computer's 

Web browser to check the status of jobs, 

perform operations on jobs, and specify 

various settings. Enter the System Manager 

ID and PIN in [System Manager ID] and 

[System PIN] from the Remote UI screen to 

log in as an administrator.

 

  

 Logging In from the Machine (p. 11) 

 Logging In from a Computer (p. 12) 
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     Logging In from the 
Machine 

 To log in as the administrator using the touch 
panel display, enter the System Manager ID and 
System PIN as follows: 
  

 System Manager ID 
 7654321 

 System PIN 
 7654321 

  

  

 The default setting for both the System Manager ID and System 
PIN is ‘7654321’. We recommend that you change the password 
after logging in to the machine. 

 In this example, the default System Manager ID and System 
PIN are used to log in. 

 1 Press (Settings/Registration). 

 2 Press [Log In]. 

   

 3 Enter the System Manager ID and System PIN → 
press [Log In]. 

 [System Manager ID]: 7654321 
 [System PIN]: 7654321 (the number you enter is masked with 
asterisks)  

   

 You are now logged in to the machine as an administrator.
Next, refer to Chapter 2, ”Starting to Use the Various Functions of 
the Machine” to specify the settings for using each function. 

 When you are finished with the operation, press [Log Out] or 
(Log In/Out) on the control panel to log out. 

  

 To return to the Main Menu screen, press (Main Menu). 
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   Logging In from a 
Computer 

 To log in as the administrator using the Remote UI, 
enter the System Manager ID and System PIN as 
follows: 
  

 System Manager ID 
 7654321 

 System PIN 
 7654321 

  

  

 The default setting for both the System Manager ID and System 
PIN is ‘7654321’. We recommend that you change the password 
after logging in to the machine. 

  

•  To log in as the administrator using the Remote UI, you must 
specify the network connection settings in advance. For 
instructions on specifying the network connection settings, 
see “Connecting to the Network,” on p. 13. 

•  If you are using a login service, see e-Manual > MEAP. 

•  For information on necessary system environment and 
preparation to start the Remote UI, see e-Manual > Remote 
UI. 

 In this example, the default System Manager ID and System 
PIN are used to log in. 

 1 Start the Web browser on your computer. 

 2 Enter ‘http://<IP address or host name of the 
machine>’ in [Address]. 

 3 Enter the System Manager ID and System PIN → 
click [Administrator Login]. 

 [System Manager ID]: 7654321 
 [System PIN]: 7654321 

   

 You are now logged in to the machine as an administrator.
Next, refer to Chapter 2, ”Starting to Use the Various Functions of 
the Machine” to specify the settings for using each function.
When you have finished specifying settings and performing 
operations, press [Log Out] to log out. 
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   Connecting to the Network 

 To use functions, such as printing and sending faxes from a computer, it is necessary to first specify the settings to connect to 
the network on the machine. In this example, a TCP/IP network environment is used. 

 

This Machine

Network

Another Machine Computer

Computer

Specify settings so that functions, such as printing 

and sending faxes from a computer can be used.

Use a TCP/IP network environment.

 

  

 Network Settings (p. 14) 

 Setting an IP Address (p. 17) 
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   Network Settings 

 To connect to the network from the machine, 
specify the following settings: 
  

 [Confirm Network Connection Set. Changes]: [On] 

 [Ethernet Driver Settings] 
 <Auto Detect>: [On] 

 [SNMP Settings] 
 <Use SNMP v. 1>: [On] 

 <Get Printer Mgmt Info from Host>: [On] 

 [Dedicated Comm. Settings] 
 <Dedicated Community>: [On] 

 <MIB Access Permission>: [Read Only] 

 [Dedicated Port Settings]: [On] 

 [Use Spool Function]: [On] 
  

  

 Before setting the network connection, it is necessary to connect 
the machine and the computer with a network cable. For 
details, see e-Manual > Network > Connecting the Machine to a 
Computer or Network. 

 1 Press (Settings/Registration). 

 2 Press [Preferences].  

   

 3 Press [Network]. 

   

 4 Press [Confirm Network Connection Set. Changes]. 

   

 5 Press [On] → [OK]. 
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 6 Press [Ethernet Driver Settings]. 

 If the desired setting is not displayed, press  or  to scroll to 
the desired setting. 

   

 7 Press [On] for <Auto Detect> → [OK].  

   

 The interface settings are now specified. Next, set the 
communication environment for the machine and the computers 
on the network. 

 8 Press [SNMP Settings]. 

   

 9 Press [On] for <Use SNMP v. 1> → [Dedicated 
Comm. Settings]. 

   

 10 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 <Dedicated Community>: [On] 
 <MIB Access Permission>: [Read Only] 

   

 11 Press [On] for <Get Printer Mgmt Info from Host> → 
[OK]. 
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 12 Press [Dedicated Port Settings]. 

   

 13 Press [On] → [OK]. 

   

 14 Press [Use Spool Function]. 

   

 15 Press [On] → [OK].  

   

 The communication environment settings are now specified.
Next, refer to “Setting an IP Address,” on p. 17 to specify the 
settings to use the network. 
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   Setting an IP Address 

 After connecting the machine to the network, you 
must specify the settings on your machine. 

 In this example, a TCP/IP type network is used. 
  

 TCP/IP Settings 
 [Use IPv4]: [On] 

 [IP Address Settings]: 192.168.1.21 

 DNS Settings 
 [DNS Server Address Settings]: 192.168.1.22
[Host Name]: host-name 

 [Domain Name]: organization.company.com 

  

 1 Press (Settings/Registration). 

 2 Press [Preferences]. 

   

 3 Press [Network]. 

   

 4 Press [TCP/IP Settings]. 

   

 5 Press [IPv4 Settings]. 

   

 6 Press [Use IPv4].  
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 10 Press [DHCP Option Settings]. 

   

 11 Specify the following settings → press [OK]. 

 In this example, the following settings are specified. 
 <Acquire Host Name>: [On] 
 <DNS Dynamic Update>: [Off ] 

   

 The IP address settings are now specified.
Next, specify the DNS settings. 

 12 Press [DNS Settings]. 

   

 7 Press [On] → [OK]. 

   

 8 Press [IP Address Settings]. 

   

 9 Specify the following settings → press [OK]. 

 In this example, the following values are entered: 
 [IP Address]: 192.168.1.21 
 [Subnet Mask]: 255.255.255.0 
 [Gateway Address]: 192.1.254.0 

   

 If you set [DHCP] to ‘On’ in [IP Address Settings], specify the DHCP 
option settings. If you set [DHCP] to ‘Off’, proceed to step 12. 
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 13 Press [DNS Server Address Settings].  

   

 14 Enter the IP address in [Primary DNS Server] for 
<IPv4> → press [OK]. 

 In this example, ‘192.168.1.22’ is entered.  

   

 15 Press [DNS Host/Domain Name Settings]. 

   

 16 Enter a host name and domain name for <IPv4> → 
press [OK]. 

 In this example, the following values are entered: 
 [Host Name]: host-name 
 [Domain Name]: organization.company.com  

   

 17 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 The DNS setting becomes effective only after turning the 
machine’s main power OFF, and then ON. 

 The DNS settings are now specified.
Next, confirm whether the network is correctly set. 

 18 Press (Settings/Registration). 

 19 Press [Preferences] → [Network] → [TCP/IP 
Settings]. 

 20 Press [IPv4 Settings]. 
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 21 Press [PING Command]. 

   

 22 Enter an IPv4 address that exists on the network → 
press [Start]. 

 In this example, ‘192.168.1.1’ is entered. 

   

 23 Confirm the response → press [OK]. 

 The communication environment settings are now specified. 
Next, refer to “Managing the Machine from a Computer,” on p. 21 
to specify the settings for using the management functions from 
a computer. 
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 This section describes the operations that the administrator must perform to enable the machine to be managed from a 
computer screen. 

 The Remote UI or SMS is used to manage the machine from a computer. 

 

Access the Remote UI to check the status of jobs, 

manage the Address Book, check the remaining 

amount of paper/toner, and perform other 

management/setting operations.

Access SMS (Service Management Service) to 

manage and install/uninstall MEAP applications 

from a computer.

Network

Computer

Remote UI

SMS

This Machine

 

 Managing by Using the Remote UI (p. 22) 

 Managing Applications Using SMS (p. 23) 

 

   Managing the Machine from a 
Computer 
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   Managing by Using the 
Remote UI 

 If you use the Remote UI, you can access the 
machine using a Web browser to manage the 
machine and check its status from a computer. 

  Preparations for Using the 

Remote UI
 To start the Remote UI, it is necessary to enable it on the 
machine. 

  

 Remote UI 
 [Remote UI]: [On] 

  

 1 Press (Settings/Registration). 

 2 Press [Management Settings]. 

   

 3 Press [License/Other]. 

   

 4 Press [Remote UI]. 

   

 5 Press [On] for <Remote UI> → [OK]. 

 You can specify the desired settings for <Use SSL>. 

   

 6 Press [Close]. 

 7 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 The [Remote UI] setting becomes effective only after turning the 
machine’s main power OFF, and then ON. 

 The Remote UI can now be used. Next, access the Remote UI from 
a computer. 

 8 Start the Web browser on your computer. 

 9 Enter ‘http://<IP address or host name of the 
machine>’ in [Address]. 
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 10 Enter the System Manager ID and System PIN → 
click [Administrator Login]. 

 [System Manager ID]: 7654321 
 [System PIN]: 7654321 

   

 You are now logged in to the Remote UI. 

 11 You can check job statuses, consumable levels, and 
change various settings. 

   

  

  

   Managing Applications 
Using SMS 

 If you use SMS, you can manage the MEAP 
applications installed in the machine from the Web 
browser on your computer. 

  

 MEAP applications are software used for customizing and 
expanding the functionality of the machine. 

Preparations for Using SMS
 To start SMS, it is necessary to enable your computer to access 
the machine. 

  

 SSL Settings 
 Setting Default Key as the Default Key 

 TCP/IP Settings 
 [Use HTTP]: [On] 

  

 1 Press (Settings/Registration). 

 2 Press [Preferences]. 
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 3 Press [Network]. 

   

 4 Press [TCP/IP Settings]. 

   

 5 Press [SSL Settings]. 

   

 6 Press [Key and Certificate]. 

   

 7 Select ‘Default Key’ → press [Set as the Default Key]. 

   

 8 Press [Yes]. 

   

 9 Press [OK] → [OK]. 

 The SSL settings are now specified. 
 Next, specify the TCP/IP settings. 
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 10 Press [Use HTTP]. 

   

 11 Press [On] → [OK]. 

   

 12 Press [Close]. 

 13 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 The default key settings and the setting for [Use HTTP] are only 
effective after you restart the machine. 

 SMS can now be used. Next, access SMS from a computer. 

 14 Start the Web browser on your computer. 

 15 Enter ‘http://<IP address or host name of the 
machine>’ in [Address]. 

 16 Enter the System Manager ID and System PIN → 
click [Administrator Login]. 

 [System Manager ID]: 7654321 
 [System PIN]: 7654321 

   

 You are now logged in to the Remote UI. 

 17 Click [Service Management Service]. 

   

 The [Login] page of SMS is displayed. 
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 18 Enter the password → press [Log In]. 

 In this example, ‘MeapSmsLogin’ is entered. 

   

  

 The default password is ‘MeapSmsLogin’ (case sensitive). We 
recommend that you change the password after logging in to 
SMS. 

  

 The SMS screen appears. 

 19 Perform MEAP application management by 
confirming and installing the MEAP applications. 

 For information on each operation, see the e-Manual. 
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 Sending Data 

 You can send originals scanned on the machine using e-mail or internet fax (I-fax). In addition, you can send a scanned 
original to a shared computer folder. 

 

Network

Shared Folder

Computer

This Machine

Scan

Original

E-Mail

I-Fax

・Communication Settings, Authentication/Encryption, etc.

・Sending an E-Mail

・Computer Settings

・Sending Data to a Computer

You can send files in JPEG 

and PDF format from the 

machine as attachments to 

e-mails.

You can send files from the 

machine to a shared folder 

on a computer.

 

 Sending E-Mail/I-Faxes (p. 29) 

 Sending to a Computer (p. 33) 
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   Sending E-Mail/I-Faxes 

 This example describes the procedure for sending 
a design proposal in PDF format. 

  

 Settings for receiving e-mail/I-faxes must also be specified. For 
information on the settings, see e-Manual > Settings/Registration 
> Common Communication Settings for E-Mail/I-Fax. 

  Preparations for Sending 

E-Mail/I-Faxes
 Communication settings must be specified to send e-mail/I-
faxes. 
 In this example, the following settings are specified: 

  

 Communications Settings 
 [SMTP Server]: 192.168.1.2 

 [E-Mail Address]: xxx01@example.com 

 Authentication/Encryption 
 <SMTP Authentication (SMTP AUTH)>: [On] 

 [User Name]: user_name*1 

 [Password]: password*1 

  

 *1 The user name and password for logging in to the SMTP server. 

   Specifying E-Mail/I-Fax Settings 

 1 Press (Settings/Registration). 

 2 Press [Function Settings]. 

   

 

 3 Press [Send]. 

   

 4 Press [E-Mail/I-Fax Settings]. 

   

 5 Press [Communication Settings]. 
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 6 Specify the following settings. 

 In this example, the following settings are specified: 
 [SMTP Server]: 192.168.1.2 
 [E-Mail Address]: xxx01@example.com 

   

  

 You can specify the desired settings for <SMTP RX> and <POP>. 
For information on the settings, see e-Manual > Settings/
Registration > Common Communication Settings for E-Mail/I-Fax. 

 7 Press [Authent./Encryption]. 

 8 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 <SMTP Authentication (SMTP AUTH)>: [On] 
 [User Name]: user_name 
 [Password]: password 

   

 The settings for sending e-mail/I-faxes are now set. 

  Sending E-Mail/I-Faxes
 Register e-mail/I-fax destinations in the Address Book before 
sending e-mail. 

   Storing New Addresses 

 When sending a scanned original using e-mail, register the 
information for the destination. 
  

 1 Press [Scan and Send]. 

   

 2 Press [Address Book]. 
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 3 Press [Register/Edit]. 

   

 4 Press [Register New Dest.]. 

   

 5 Press [E-Mail] or [I-Fax]. 

   

 6 Specify the following settings → press [OK]. 

 <E-Mail Settings> 
 In this example, the following settings are specified: 
 [Name]: planning dept. 
 [E-Mail Address]: xxx07@example.com 

   

 The name registered here is used as a display name for the 
E-mail address. 

 <I-Fax Settings> 
 In this example, the following settings are specified: 
 [Mode:]: Simple 
 [I-Fax Address]: user1@xxx.xxx.xxx.xxx 

   

 7 Press [Close]. 

 8 Press [OK]. 
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   Sending an E-Mail Message or I-Fax 

 The scanned data is sent to a destination registered in “Storing 
New Addresses,” on p. 30 as an e-mail attachment. 

 1 Place your originals. 

 2 Press [Address Book]. 

   

 3 Select [planning dept.] → press [OK]. 

   

 4 Change the settings as necessary. 

   

 5 Press (Start). 

 If the [Set SMTP Authentication] screen is displayed, enter the 
user name and password → press [OK]. 
 If the <Original Size> screen is displayed, specify the size of the 
original → press [OK]. 

 6 Press [Start Sending]. 

   

 The data is attached to the e-mail and sent. 
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 4 From the [Start] menu, right-click [Network] → 
select [Properties]. 

   

 5 Click [Manage network connections] → [View 
Status] for [Local Area Connection]. 

   

  

  

   Sending to a Computer 

 This example describes the procedure for 
scanning an original and sending it to a file server 
(computer) in PDF format. 

  Preparations for Sending to 

a Computer
 To send data to a computer, you must specify settings for the 
shared folder. 
 In this example, the following settings are specified: 

  

 ●  Computer Settings 

 TCP/IP Settings 
 Enable NetBIOS over TCP/IP 

 Adding users 
 [User Name]: user_name 

 [Password]: password 

 Creating a shared folder 
 [Share Name]: share 

 [Permissions]: Full Control 

   Setting a Computer 

 Data scanned with the machine can be saved to a shared 
folder. The shared folder can be set from your computer. 
 The following example describes the procedure for setting a 
shared folder with Windows Vista: 

 1 Log on to Windows with administrator privileges. 

 2 Click (Start) → right-click [Computer]. 

 3 Click [Properties] → check the computer name. 
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 8 Select [Internet Protocol Version 4 (TCP/IPv4)] → 
click [Properties]. 

   

 9 Click [Advanced] on the [General] tab. 

   

 6 Click [Properties]. 

   

 7 Select the following items. 

•  [Client for Microsoft Networks] 

•  [File and Printer Sharing for Microsoft Networks] 

•  [Internet Protocol Version 4 (TCP/IPv4)] 
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 13 From the [Start] menu, right-click [Computer] → 
select [Manage]. 

   

 14 Click [Local Users and Groups] in [System Tools] → 
right-click the [Users] folder → select [New User] 
from the pop-up menu. 

   

 10 Click the [WINS] tab. 

   

 11 Select [Enable NetBIOS over TCP/IP] → click [OK]. 

   

 12 Restart the computer. 

 The network settings are now specified.
Next, create a user for accessing the shared folder from the 
machine. 
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 15 Specify the following settings → click [Create] → 
[Close]. 

 In this example, the following values are entered: 
 [User Name]: user_name 
 [Password]: password 
 [Confirm password]: password 

   

 The user is now created.
Next, create a folder for sending data from the machine. 

 16 Create the folder to save the data to in a location of 
your choice. 

 In this example, a folder named ‘share’ is created. 

   

 17 Right-click the folder → select [Share] from the 
menu that appears. 

   

 18 Select the user to perform sharing with → click 
[Add] → [Share]. 

   

 19 Click [Exit]. 

 The setting of the computer are now specified. 



37

S
ta

rt
in

g
 t

o
 U

se
 t

h
e

 V
a

ri
o

u
s 

Fu
n

ct
io

n
s 

o
f 

th
e

 M
a

ch
in

e

2

Sending to a Computer
 You can send data scanned with the machine to the shared 
folder. 

   Storing New Addresses 

 Register the information for the shared folder created in 
“Setting a Computer,” on p. 33 to the Address Book of the 
machine. 

 1 Press [Scan and Send]. 

   

 2 Press [Address Book]. 

   

  

 3 Press [Register/Edit]. 

   

 4 Press [Register New Dest.]. 

   

 5 Press [File]. 
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 6 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 [Name]: Original 
 <Protocol>: [Windows (SMB)] 
 [Host Name]: \\user-1\share 
 [User Name]: user_name 
 [Password]: password 

•  For [Host Name], enter <\\<name of your computer>\<name 
of the shared folder>>. 

•  For [Folder Path], enter <\\<name of a folder inside the shared 
folder>>. This can be omitted as necessary. 

   

 7 Press [Close]. 

 8 Press [OK]. 

 Sending Data to a Computer 

 Send a scanned original to the shared folder registered in 
“Storing New Addresses,” on p. 37. 

 1 Place your originals. 

 2 Press [Address Book]. 

   

 3 Select [Original] → press [OK]. 

   

 4 Change the settings as necessary. 

   

 5 Press (Start). 

 If the <Original Size> screen is displayed, specify the size of the 
original → press [OK]. 

 6 Press [Start Sending]. 

   

 The scanned original is sent to the shared folder. 
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 Sending a Fax 

 Originals scanned with the machine can be sent by fax. In addition, you can send data stored in a computer using the Fax 
function of the machine. 

 

・Settings for Using Remote Fax (Server 

Machine/Client Machine)

・Sending/Receiving a Fax

・Fax Numbers, Fax Line Settings, etc.

・Sending a Fax

・Fax Numbers, Fax Line Settings, etc.

・Sending a Fax

By using the Remote Fax 

function on your machine, 

you can send/receive faxes 

using another fax machine.

You can scan originals 

with the machine send 

them by fax.

Scan

Send

This Machine

Original

You can send faxes from a 

computer using the Fax 

function of the machine.

Computer

No Fax 
Board

Remote 
Fax TX

Install the 
Driver

Fax

 

  

  

 Sending/Receiving Faxes via the 
Remote Fax Server (p. 45) 

 Sending from a Computer (p. 52) 

 Sending Faxes (p. 40) 
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 3 Press [Send]. 

   

 4 Press [Fax Settings]. 

   

 5 Press [Set Line]. 

   

  

   Sending Faxes 

 This example describes the procedure for sending 
a fax. 

Preparations for Sending a 

Fax
 To send a fax, you must specify a fax number, unit name, and 
other settings. 
 In this example, the following settings are specified: 

  

 Fax Number 
 012XXXXXXX 

 Unit Name 
 sales dept. 

 Line Type 
 Tone 

 TX Terminal ID 
 Print 

  

 Registering User Data 

 Register the fax number and unit name displayed/printed on 
the destination machine. Set the line type to ‘Tone’. 

 1 Press (Settings/Registration). 

 2 Press [Function Settings]. 

   



41

S
ta

rt
in

g
 t

o
 U

se
 t

h
e

 V
a

ri
o

u
s 

Fu
n

ct
io

n
s 

o
f 

th
e

 M
a

ch
in

e

2

 6 Select the desired line. 

 The number of lines that appear depends on the optional 
equipment attached to the machine. In this example, [Line 1] is 
pressed. 

   

 7 Press [Register Unit Telephone Number]. 

   

 8 Enter the sender’s fax number using  -  
(numeric keys). 

 In this example, <012XXXXXXX> is entered. 

   

 9 Press [OK]. 

 The fax number is now registered. Next, register the unit name. 

 10 Press [Register Unit Name]. 

   

 11 Enter a name → press [OK]. 

 In this example, <sales dept.> is entered. 

   

 The unit name is now registered. Next, select the line type. 

 12 Press [Select Line Type]. 
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 13 Press [Tone] → [OK]. 

   

 14 Press [Close]. 

 Printing the TX Terminal ID 

 Set the machine so that information for the sender appears on 
sent documents. 

 1 Press (Settings/Registration). 

 2 Press [Function Settings]. 

   

 3 Press [Send]. 

   

 4 Press [Common Settings]. 

   

 5 Press [TX Terminal ID]. 

   

 6 Press [Print] → specify the following settings → 
press [OK]. 

 In this example, the following settings are specified: 
 [Print Position]: [Outside] 
 [Display Destination Unit Name]: [On] 
 [Telephone # Mark]: [Fax] 

   

 7 Press [Close]. 
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 3 Press [Register/Edit]. 

   

 4 Press [Register New Dest.]. 

   

 5 Press [Fax]. 

   

  Sending Faxes
 Register the destination in the Address Book to send faxes to. 

   Storing New Addresses 

 Register the information for the destination in the Address 
Book. In this example, information for the “central sales dept.” is 
registered in the Address Book. 

 1 Press [Fax]. 

   

 2 Press [Address Book]. 
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 6 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 [Name]: central sales dept. 
 Fax Number: 123XXXXXXX 

   

 7 Press [OK] → [Close]. 

 8 Press [OK]. 

   Sending Faxes 

 Send a fax to the destination registered in “Storing New 
Addresses,” on p. 43. 

 1 Place your originals. 

 2 Press [Address Book]. 

   

 3 Select [central sales dept.]. 

   

 4 Press (Start). 

 If the <Original Size> screen is displayed, specify the size of the 
original → press [OK]. 

 5 Press [Start Sending]. 

   

 The fax is sent. 

 Receiving Faxes 

 For information on the following functions for receiving the fax 
documents, see e-Manual. 

 ●  Memory Lock Mode 

 You can set to store received fax documents in the 
Memory RX Inbox without printing them. For more 
information on the settings, see e-Manual > Fax > 
Sending/Receiving a Fax > Setting the Memory Lock 
Mode. 

 ●  Forwarding Received Fax Documents 

 You can set to forward received fax documents 
automatically to a registered destination, such as 
a personal computer. For more information on the 
settings, see e-Manual > Settings/Registration > Function 
Settings > Receive/Forward > Common Settings > 
Storing Forwarding Settings. 
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   Sending/Receiving Faxes 
via the Remote Fax 
Server 

 This example describes the procedures for setting 
the machine that forwards the fax, the “server,” and 
the machine from/to which the fax is sent, the 
“client.” 

Preparations for Sending a 

Remote Fax
 To send a remote fax, it is necessary to specify the following 
settings. 

  

 ●  Server Settings
[Remote Fax Settings] 

 [Use Remote Fax]: [On] 

 ●  Client Settings
[Remote Fax TX Settings] 

 [Remote Fax Server Address]: 192.168.1.24 (IP address of 
the server) 

  

   Setting the Server Machine 

 To use the machine equipped with a fax board as a server, you 
must specify the Remote Fax TX settings on the machine. 

 1 Press (Settings/Registration). 

 2 Press [Function Settings]. 

   

 3 Press [Send]. 

   

 4 Press [Fax Settings]. 

   

 5 Press [Remote Fax Settings]. 
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 6 Press [Use Remote Fax]. 

   

 7 Press [On] → [OK]. 

   

 8 Press [Close]. 

 9 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 The [Use Remote Fax] setting becomes effective only after 
turning the machine’s main power OFF, and then ON. 

   Setting the Client Machine 

 Set the IP address of the server to send using in the client 
machine. 

 1 Press (Settings/Registration). 

 2 Press [Function Settings]. 

   

 3 Press [Send]. 

   

 4 Press [Fax Settings]. 
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 5 Press [Remote Fax TX Settings]. 

   

 6 Press [Remote Fax Server Address]. 

   

 7 Enter the IP address → press [OK]. 

 In this example, <192.168.1.24> is entered for the IP address of 
the server. 

   

 8 Press [Close]. 

 The client settings are now specified. 

Sending Faxes via the 

Remote Fax Server
 Send faxes using the remote fax server. 

 1 Place your originals. 

 2 Press [Fax]. 

   

 3 Enter the destination’s fax number using  -  
(numeric keys). 

 In this example, <123XXXXXXX> is entered. 

   

  

 You can also specify a destination from the Address Book. For 
more information, see “Sending Faxes,” on p. 43. 

 4 Press (Start). 

 If the <Original Size> screen is displayed, specify the size of the 
original → press [OK]. 
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 5 Press [Start Sending]. 

   

 The fax is sent. 

Preparations for Receiving a 

Remote Fax
 To receive a remote fax using the Remote Fax server, you must 
specify the following settings for the server machine and client 
machine respectively. 

  

 ●  Server Settings 

 Register Destinations 
 [I-Fax Address]: xxx01@example.com  

 Forwarding Settings 

 ●  Client Settings 

 Communications Settings 
 <SMTP RX>: [On] 
 [E-Mail Address]: xxx01@example.com 

  

  

 Press to specify a destination not stored in the Address Book. 

   Setting the Server Machine 

 You must specify the settings so that fax data received by the 
server machine is forwarded to the client machine as an I-fax. 
 In this example, the e-mail address for the client machine is 
registered as an I-fax address. 

 1 Press (Settings/Registration). 

 2 Press [Set Destination]. 

   

 3 Press [Register Destinations]. 

   

 4 Press [Register New Dest.]. 
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 5 Press [I-Fax]. 

   

 6 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 [Name]: Client machine 
 [I-Fax Address]: xxx01@example.com 

   

 7 Press [Close]. 

 The I-fax address for the client machine is now registered. Next, 
set the forwarding settings. 

 8 Press [Function Settings]. 

   

 9 Press [Receive/Forward]. 

   

 10 Press [Common Settings]. 

   

 11 Press [Forwarding Settings]. 
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 15 Press [Address Book]. 

   

 16 Select [Client machine] → press [OK]. 

   

  

 For more information on forwarding settings, see e-Manual > 
Fax/I-Fax Inbox. 

 17 Press [Close]. 

 12 Press [Register]. 

   

 13 Enter [Condition Name]. 

 In this example, <Remote RX> is entered. 

   

 14 Press [Forwarding Destination]. 
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 5 Press [Communication Settings]. 

   

 6 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 <SMTP RX>: [On] 
 [E-Mail Address]: xxx01@example.com 

   

 7 Press [Close]. 

  

 To use the SMTP receiving function, it is necessary to register 
the host name for the machine to the DNS server. For more 
information, see e-Manual > Network. 

  

 Setting the Client Machine 

 You must specify the settings on the client machine for it to 
receive I-fax data forwarded from the server machine. 
 In this example, SMTP server receive is set. 

 1 Press (Settings/Registration). 

 2 Press [Function Settings]. 

   

 3 Press [Send]. 

   

 4 Press [E-Mail/I-Fax Settings]. 
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   Sending from a 
Computer 

 This example describes the procedure for sending 
a document created on a computer as a fax using 
the machine. 

  

•  The procedure for displaying the fax driver screen may differ, 
depending on the applications you are using. For details, see the 
instruction manuals provided with the application software. 

•  The display may differ according to the operating system and 
version of the fax driver. 

Preparations for Sending
 To send a fax from your computer using the machine, you 
must install the fax driver in your computer. After installing the 
fax driver, specify the fax settings. 

 Installing the Printer Driver 

 This example describes the procedure for installing the fax 
driver for Windows Vista. 

 1 Insert the CD-ROM (the CD-ROM that contains the 
fax driver) into your computer. 

 In this example, the Windows fax driver is used.  

 2 On the CD-ROM Menu screen, click [Installation]. 

   

 To browse the Fax Driver Installation Guide, click [Manuals] before 
you click [Installation]. 

 3 Follow the instructions on the screen to complete 
the installation. 

 The fax driver is now installed.
Next, set the fax environment. 

 4 Click  (Start) → [Control Panel] → [Printer] in 
Windows. 

   

 5 Right-click the icon of the fax you use → select 
[Properties]. 
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 6 Click the [Device Settings] tab → [Get Device 
Status]. 

   

 7 Click [OK]. 

 The fax environment settings are now specified. 

  Sending Faxes from a 

Computer
 Specify a destination and send a fax. The following example 
describes the procedure for sending a document, created 
using Microsoft Office Word 2007. 

 1 On your computer, open the document to send 
using the fax function. 

 2 Select [Print] from the menu. 

   

 The [Print] dialog box is displayed. 

 3 Select the fax name to use → click [Print]. 

   

 The [Fax Sending Settings] dialog box is displayed. 

 4 On the [Sending Settings] sheet, enter the 
recipient’s name and fax number → click [Add to 
Destination List]. 

   

 5 Click [OK]. 

   

 The fax is sent. 
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   Scanning an Original 

 You can use the machine as a scanner. Scanned data can be stored in a computer, the machine’s Mail Box, Advanced Box, 
memory media, and the Advanced Box of another imageRUNNER ADVANCE series machine that is accessible on the same 
network. 

 

・Installing the Scanner Driver

・Using the Remote Scanner

・Scanning an Original from an Application

・Settings for Displaying/Using a Store Location

・Selecting a Store Location for Scanning

You can place an original 

on the machine and scan 

it from an application on 

your computer.

Install the 
Driver

Network

Original Computer

Advanced 
Box

Mail Box/
Advanced 
Box

Scan

You can store scanned 

originals in the Mail Box 

and Advanced Box.

Memory Media

You can store scanned originals 

in the Advanced Box of another 

imageRUNNER ADVANCE series 

machine on the network or 

memory media.

 

 Storing Data in the Machine, Memory 
Media, Etc. (p. 58) 

 Storing Data in a Computer (p. 55) 
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   Storing Data in a 
Computer 

 This example describes the procedure for 
specifying the settings required to scan and 
scanning an original into a computer.  

  

•  Remote scanning methods may differ, depending on the 
applications you are using. For details, see the instruction 
manuals provided with the application software. 

•  The window displayed may differ according to the operating 
system etc. 

Preparations for Scanning
 To use the Scan function of the machine, it is necessary to 
install the scanner driver (software for specifying scanner 
settings). 
 The scanner driver can be installed from the same User 
Software CD-ROM used for installing the printer driver. 
 After that, specify the settings to use the remote scanner on 
the machine. 
 In this example, the following settings are specified: 

  

 [Scanner] screen of the machine: 
 [Online] 

 [ScanGear Tool] on your computer: 
 The name of your scanner 

  

 Installing the Printer Driver 

 This example describes the procedure for installing the 
scanner driver for Windows Vista. 

 1 Insert the CD-ROM in your computer. 

 Color Network ScanGear is used here. 

 2 On the CD-ROM Menu screen, click [Installation]. 

   

 To browse the Network ScanGear Installation Guide, click 
[Manuals] before you click [Installation]. 

 3 Follow the instructions on the screen to complete 
the installation. 

 The scanner driver is now installed.
Next, enable remote scanning. 

 Setting Scanning Online 

 To use the Scan function, it is necessary to enable remote 
scanning on the machine and enable the network scanner to 
use on your computer. 

 1 Press [Scanner]. 
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 2 On the [Scanner] screen, press [Online]. 

   

 The scanner is now online. 

 Scanned data from your computer can now be received.
Next, set the scanner to use on your computer. 

 3 Click (Start) → [Programs] → [Color Network 
ScanGear] → [ScanGear Tool]. 

   

 ScanGear Tool is started. 

 4 Click [Discover]. 

   

 Scanners on the network are automatically discovered, and the 
searched scanners are displayed in [Select Scanner from List]. 

 5 Select the scanner to use → click [Select]. 

   

 6 Click [Exit]. 

 ScanGear Tool is closed. 

 Remote scanning is now enabled. 
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  Scanning an Original
 The following example describes the procedure for placing 
an original on the platen glass of the machine, and using 
remote scanning from your computer to paste the data into a 
Microsoft Office Word 2007 document. 

 1 Confirm that remote scanning is online. 

 2 Place the original on the platen glass. 

   

 3 Start Microsoft Office Word 2007. 

 4 Click the [Insert] tab → [Clip Art]. 

   

 The [Clip Art] pane is displayed. 

 5 Click [Organize clips]. 

   

 Microsoft Clip Organizer is started. 

 6 Select [File] → [Add Clips to Organizer] → [From 
Scanner or Camera]. 

 The [Insert Picture from Scanner or Camera] dialog box is 
displayed. 

 7 From the [Device] drop-down list, select Color 
Network ScanGear → click [Custom Insert]. 

   

 Color Network ScanGear screen is displayed. 

 8 Click the [Main] tab → select [Platen] for <Original 
Placement>. 

   

 9 Specify the scanning conditions, such as color mode 
and resolution. 

 Click [Preview] to view a preview. 

 10 Click [Scan]. 

 Scanning starts. 
 When scanning is complete, the Color Network ScanGear screen 
closes and the scanned image is transferred to [Color Network 
ScanGear Vx.xx] in [My Collections] in Microsoft Clip Organizer. 

 11 Open a document using Microsoft Office Word 2007. 
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   Storing Data in the 
Machine, Memory Media, 
Etc. 

 This section describes the procedure for storing 
data in the Mail Box, Advanced Box, the Advanced 
Box of another machine on the same network, and 
memory media (hereinafter referred to as “storage 
locations”). 

  Preparations for Scanning
 To store scanned data in a storage location, you must specify 
the following settings: 

  

  

 ●  Mail Box 

 [Store Location Display Settings] 

  <Mail Box>: [On] 

 ●  Advanced Box 

 [Store Location Display Settings] 

  <Advanced Box/Network>: [On] 

 ●  Network 

 Server Settings 

 [Open to Public]: [By SMB] 

 [SMB Server Settings] 

  <Use SMB Server>: [On] 

  [Server Name]: SERVER 

 Client Settings 

  [Store Location Display Settings] 

  <Advanced Box/Network>: [On] 

 [Network Place Settings] 

  [Name]: images 

  <Protocol>: [SMB] 

  [Location]: \\192.168.1.23\share 

 [Protocol for External Reference] 

  <SMB>: [On] 

 ●  Memory Media 

 [Store Location Display Settings] 

  <Memory Media>: [On] 

 [Use MEAP Driver for External USB Device]: [Off ] 

 [Use Scan/Print Function] 

  <Use Scan Function>: [On] 

  <Use Print Function>: [On] 

  

  

 If the imagePASS or ColorPASS is attached to the machine, you 
cannot open the Advanced Box of the machine externally as an 
SMB server. Set to open as a WebDAV server on the network. For 
information on the settings, see e-Manual > Security. 

 12 Drag the image scanned using Microsoft Clip 
Organizer, and drop it into the area where you want 
to add the image. 

   

 The image is added to the area where drag-and-drop was 
performed. 
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 You can set a name and PIN for [Mail Box], as necessary. For 
information on the settings, see e-Manual > Security. 

   Using a Mail Box 

 To use a mail box, specify the Store Location Display Settings. 

 1 Press (Settings/Registration). 

 2 Press [Preferences]. 

   

 3 Press [Display Settings]. 

   

 4 Press [Store Location Display Settings]. 

   

 5 Set <Mail Box> to ‘On’ → press [OK]. 

   

 6 Press [Close]. 

 7 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 The [Store Location Display Settings] setting becomes effective 
only after turning the machine’s main power OFF, and then ON. 

   Using the Advanced Box 

 To use the Advanced Box, specify Store Location Display 
Settings. 
  
 To display the Advanced Box, set <Advanced Box/Network> 
to ‘On’ in step 5 of “Using a Mail Box,” on p. 59. 

 Setting Up an Advanced Box on the Network 

 To use the network from the machine, you must specify 
the settings for the server machine and client machine 
respectively. On the server machine, set the Open to Public 
settings and SMB server settings. On the client machine, set 
the Store Location Display settings, Network Place settings, 
and Protocol for External Reference settings. 

 ●  Server Settings 

 1 Press (Settings/Registration). 
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 5 Press [Open to Public]. 

   

 6 Press [By SMB] → [OK]. 

   

 Next, specify the SMB server settings. 

 7 Press [Preferences]. 

   

 2 Press [Function Settings]. 

   

 3 Press [Store/Access Files]. 

   

 4 Press [Advanced Box Settings]. 

   



61

S
ta

rt
in

g
 t

o
 U

se
 t

h
e

 V
a

ri
o

u
s 

Fu
n

ct
io

n
s 

o
f 

th
e

 M
a

ch
in

e

2

 12 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 The [Open to Public] setting is effective only after you restart the 
machine. 

 ●  Client Settings 

 1 Set <Advanced Box/Network> to ‘On’ in [Store 
Location Display Settings]. 

 To display the Advanced Box of another machine on the 
network, set <Advanced Box/Network> to ‘On’ in step 5 of “Using 
a Mail Box,” on p. 59. 
 Next, specify the Network Place and Protocol for External 
Reference settings. 

 2 Press [Function Settings]. 

   

 3 Press [Store/Access Files]. 

   

 8 Press [Network]. 

   

 9 Press [SMB Server Settings]. 

   

 10 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 <Use SMB Server>: [On] 
 [Server Name]: SERVER 

   

 11 Press [Close]. 
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 4 Press [Network Settings]. 

   

 5 Press [Network Place Settings]. 

   

 6 Press [Register]. 

   

 7 Specify the following settings → press [OK]. 

 In this example, the following settings are specified: 
 [Name]: images 
 <Protocol>: [SMB] 
 [Location]: \\192.168.1.23\share 

   

 8 Press [Close]. 

 The Network Place Settings are now set. 
 Next, specify the Protocol for External Reference settings. 

 9 Press [Protocol for External Reference]. 

   

 10 Set <SMB> to ‘On’ → press [OK]. 
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 11 Press [Close]. 

 12 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 [Store Location Display Settings] is only effective after you restart 
the machine. 

 Using Memory Media 

 To use memory media, specify Store Location Display Settings 
and the USB settings. 

 1 Set <Memory Media> to ‘On’ in [Store Location 
Display Settings]. 

 To display memory media, set <Memory Media> to ‘On’ in step 5 
of “Using a Mail Box,” on p. 59. 
 Next, specify the USB settings. 

 2 Press [Preferences]. 

   

 3 Press [External Interface]. 

   

 4 Press [USB Settings]. 

   

 5 Press [Use MEAP Driver for External USB Device]. 

   

 6 Press [Off] → [OK]. 
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 7 Press [Close]. 

 The USB setting is set. 
 Next, follow the steps below to enable the scan/print functions. 

 8 Press [Function Settings]. 

   

 9 Press [Store/Access Files]. 

   

 10 Press [Memory Media Settings]. 

   

 11 Press [Use Scan/Print Function]. 

   

 12 Set <Use Scan/Print Function> and <Use Print 
Function> to ‘On’ → press [OK]. 

   

 13 Press [Close]. 

 14 Turn OFF the main power of the machine, and then 
turn ON the main power again. 

 The [Use MEAP Driver for External USB Device], <Use Scan 
Function>, and <Use Print Function> settings become effective 
only after turning the machine’s main power OFF, and then ON. 

Scanning an Original
 You can store data scanned with the machine in a storage 
location. This section describes the procedure for storing data 
in the Advanced Box of another imageRUNNER ADVANCE 
series machine on the network. 

 1 Place your original on the machine. 
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 2 Press [Scan and Store]. 

   

 3 Press [Network]. 

   

 4 Select the desired storage location. 

   

 If an authentication screen is displayed, enter the user name and 
password to log in. 

 5 Press [Scan]. 

   

 6 Change the settings as necessary. 

   

 7 Press (Start). 

 If the <Scan Size> screen is displayed, specify the scan size → 
press [OK]. 

 8 Press [Start Storing]. 

   

 The scanned original is stored in the Advanced Box of another 
imageRUNNER ADVANCE series machine on the network. 

 9 Press [Close]. 
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 Printing an Original 

 You can print data stored in the machine’s Mail Box, Advanced Box, memory media, or the Advanced Box of another 
imageRUNNER ADVANCE series machine on the network, and data created using a computer. 

 This section describes the procedure for printing files stored in the Advanced Box of another imageRUNNER ADVANCE series 
machine on the network, as an example. 

 

・Installing the Driver

・Specifying Printer Settings

Install the 
Driver

Network

Computer

Output

You can print documents 

created on your computer 

with the machine.

You can print data stored 

in the Mail Box/Advanced 

Box of the machine or 

memory media.

Memory 
Media

Mail Box/
Advanced Box of 
This Machine 
(Client Machine)

Advanced Box of Another 
imageRUNNER ADVANCE 
Series Machine (Server 
Machine)

You can print data stored in 

the Advanced Box of another 

imageRUNNER ADVANCE 

series machine on the 

network.

Print

・Settings for Displaying/Using a Store Location

・Selecting Data for Printing

 

  

  

 Printing from a Computer 
(p. 67) 

 Printing Stored Data (p. 69) 
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   Printing from a 
Computer 

 To perform printing, it is necessary to install the 
printer driver in a computer. 

  

•  Printing methods may differ, depending on the applications you 
are using. For details, see the instruction manuals provided with 
the application software. 

•  The screens may differ, depending on the operating system, and 
the type and version of the printer driver you are using. 

Preparations for Printing
 A printer driver is software required for printing from 
application software. It is necessary to install a printer driver in 
a computer to use the Print function. 

 Installing the Printer Driver 

 This example describes the procedure for installing the printer 
driver for Windows Vista. 

 1 Insert the CD-ROM (the CD-ROM that contains the 
printer driver) into your computer. 

 In this example, the LIPS LX printer driver for Windows is used. 

 2 On the CD-ROM Menu screen, click [Installation]. 

   

 To browse the Printer Driver Installation Guide, click [Manuals] 
before you click [Installation]. 

 3 Follow the instructions on the screen to complete 
the installation. 

 The printer driver is now installed.
Next, set the printer environment. 

 4 Click  (Start) → [Control Panel] → [Printer] in 
Windows. 

   

 5 Right-click the icon of the printer → select 
[Properties]. 
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Printing from a Computer
 Print documents created on your computer with the machine. 
The following example describes the procedure for printing a 
document, created using Microsoft Office Word 2007: 

 1 Open the Word document you want to print → click 
[File] → [Print]. 

   

 2 Select the printer you use for [Name]. 

   

 3 Click [Properties]. 

   

 6 Click the [Device Settings] tab → [Get Device 
Status]. 

   

 7 Click [OK]. 

 The printer environment settings are now specified. 
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 4 Specify the page settings, finishing modes, etc. → 
click [OK]. 

   

  

 The default setting for [Print Style] is [2-sided printing]. However, 
for some driver versions, [1-sided printing] is the default setting. 

 5 Set the range to print and the number of copies → 
click [OK]. 

   

 The document is printed. 

  

   Printing Stored Data 

 This section describes the procedure for printing 
files that are stored in the Advanced Box of another 
imageRUNNER ADVANCE series machine on the 
network. 

Preparations for Printing
 To print stored files, you must specify the following settings: 

  

 ●  Mail Box 

 [Store Location Display Settings] 

  <Mail Box>: [On] 

 ●  Advanced Box 

 [Store Location Display Settings] 

  <Advanced Box/Network>: [On] 

 ●  Network 

 Server Settings 

  [Open to Public]: [By SMB] 

 [SMB Server Settings] 

  <Use SMB Server>: [On] 

 [Server Name]: SERVER 

 Client Settings 

 [Store Location Display Settings] 

  <Advanced Box/Network>: [On] 

 [Network Place Settings] 

  [Name]:images 

  <Protocol>: [SMB] 

  [Location]: \\192.168.1.23\share 

 [Protocol for External Reference] 

  <SMB>: [On] 

 ●  Memory Media 

 [Store Location Display Settings] 

  <Memory Media>: [On] 

 [Use MEAP Driver for External USB Device]: [Off ] 

 [Use Scan/Print Function] 

  <Use Scan Function>: [On] 

  <Use Print Function>: [On] 

  

  

 For more information on the settings required when preparing 
for printing, see “Preparations for Scanning,” on p. 58. 



70

S
ta

rt
in

g
 t

o
 U

se
 t

h
e

 V
a

ri
o

u
s 

Fu
n

ct
io

n
s 

o
f 

th
e

 M
a

ch
in

e

2

 Printing Stored Data 

 You can print files stored in the Advanced Box of another 
imageRUNNER ADVANCE series machine on the network. 

 1 Press [Access Stored Files]. 

   

 2 Press [Network]. 

   

 3 Select the desired storage location. 

   

 If an authentication screen is displayed, enter the user name 
and password to log in. 

 4 Select a file → press [Print]. 

   

 If the Select Paper screen is displayed, select the paper source. 

 5 Specify the settings on the Print Settings screen, as 
necessary. 

   

 6 Press [Start Printing]. 

   

 The selected file is printed. 
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 Installing the System Options/
MEAP Applications 

 Using the Register/Update Software function, you can install the System Options/MEAP Applications to the machine. You can 
use this function from both the touch panel display and the computer (Remote UI). 

 

Delivery Server

・Access the delivery server

・Install software

This Machine

Access Using 

the Remote UI

License Authentication/MEAP 

Application Delivery

・Obtain the license file

・Install software

Obtain the License 

Key/License File

1234-5678-1234…

* For the MEAP applications, an 

application file is necessary.

Install the License File Using the 

Remote UI (System 

Options/MEAP Applications*)

Register the License Key 

Using the Touch Panel 

Display (System Options)

Depending on the system 

option/MEAP application, you 

can download the manual and 

related software etc.

Start the installed MEAP 

application from the SMS 

screen.

Installing by Not Connecting This 

Machine to an Outside Network

Network

Access Using the 

Touch Panel 

Display

Installing by Connecting This 

Machine to an Outside Network

 

 Installing by Connecting This Machine to an 
Outside Network (p. 74) 

   Starting the MEAP Applications 
(p. 79) 

 Installing by Not Connecting This 
Machine to an Outside Network (p. 76) 

 Downloading the Manuals and 
Related Software (p. 79) 
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 System Options/MEAP 
Applications 

 You can enhance the functions of the machine 
by installing various system options and MEAP 
applications. 

  

 To activate the ACCESS MANAGEMENT SYSTEM*, contact your 
local authorized Canon dealer. 

 * This function enables you to restrict the use of various functions 
for each user. Restricting the Send function enables you to 
reduce the risk of confidential information being leaked, and 
restricting users from making one-sided printing of multiple 
page documents enables printing costs to be reduced. 

 ●  System Options 
 The following are the system options you can install on this 
machine. 

•  PCL Printer Kit 

•  PS Printer Kit 

•   Direct Print Kit (for PDF/XPS)  

•  Barcode Printing Kit 

•  PCL International Font Set 

•  Remote Fax Kit 

•  Universal Send Advanced Feature Set 

•  Universal Send Security Feature Set 

•  Universal Send Digital User Signature Kit 

•  Secure Watermark 

•  Document Scan Lock Kit 

•  Web Access Software 

•  Encrypted Secure Print Software 

•    Remote Operator’s Software Kit 

 ●  MEAP applications 
 To enhance the functions of the machine without using the 
above system options, install the MEAP applications. 

  

•  License registration may be required, depending on the System 
Options/MEAP Applications that you are using. 

•  If you want to perform MEAP applications management, such as 
the ones shown below, use SMS (Service Management Service). 
(See e-Manual > MEAP.) 

•  Checking the MEAP applications installed on this machine 

•  Checking the hard disk space used by MEAP applications 

•  Adding a license to an installed MEAP application 

Installing the System 

Options/MEAP Applications
 The procedures to install the system options or MEAP 
applications on the machine differ, depending on whether the 
machine is connected or not to an outside network. Select the 
procedure that matches your conditions using the references 
below. 
•  See “Installing by Connecting This Machine to an Outside 

Network,” on p. 74. 

•  See “Installing by Not Connecting This Machine to an Outside 
Network,” on p. 76. 

  

•  For instructions on connecting to an external network, see 
“Connecting to the Network,” on p. 13. 

•  Multiple users cannot use the Register/Update Software function 
at the same time. 

•  If another user is logged in to SMS (Service Management 
Service), you cannot use the Register/Update Software function 
from the Remote UI. 

•  If you perform one of the following operations, you cannot use 
“Register/Update Software” from the Remote UI for a certain 
period of time: 

•  If you close the Web browser without pressing [Portal] or [Log 
Out], when the Remote Login Service for SMS is set. 

•  If you close the Web browser without pressing [Portal], when 
the Remote Login Service for SMS is not set. 

•  If you close the Web browser without pressing [Log Out from 
SMS], [To Remote UI], or [Log Out] for SMS. 
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   Installing by Connecting 
This Machine to an 
Outside Network 

 If the machine is connected to an external 
network, you can install system options/MEAP 
applications via a delivery server. Install using one 
of the following procedures. 
•  See “Using the Touch Panel Display to Install (Delivery),” on p. 74. 

•  See “Using the Remote UI to Install (Delivery),” on p. 75. 

  

•  To check that the transmission with the delivery server is 
properly operating, if necessary, perform a transmission test 
before installation. (See “Using the Touch Panel Display,” on p. 82, 
and “Using the Remote UI,” on p. 84.) 

•  Prepare the License Access Number certificate that was included 
in the package. 

•  When you install MEAP applications, you must start the 
application before using the MEAP application. (See “Starting 
the MEAP Applications,” on p. 79.) 

  Using the Touch Panel 

Display to Install (Delivery)
 You can install system options/MEAP applications in the 
machine using the touch panel display. 

  

•  The maximum number of MEAP applications that can be 
installed is 19. 

•  The maximum amount of hard disk space allocated to install 
MEAP applications is 1 GB. 

•  There may be other system requirements for installation, 
depending on the MEAP application. For more information, see 
the manual provided with each MEAP application. 

 1 Press (Settings/Registration)→ [Management 
Settings] → [License/Other] → [Register/Update 
Software]. 

 2 Press [Install Applications/Options]. 

   

 3 Press [License Access Number]. 

   

 4 Enter the license access number four digits at a 
time. 

   

 Enter four digits of the license access number → press [OK]. 
Repeat this step four times to enter a total of 16 digits for the 
License Access Number. 

 5 Press [Start]. 
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 6 Select the system options and MEAP applications → 
press [Install]. 

   

 [Do Not Start]: Press to only install the MEAP application and not 
start the application. 

  

 If [Do Not Start] is selected when installing MEAP applications, 
you must start the application before using the MEAP 
application. (See “Starting the MEAP Applications,” on p. 79.) 

  

 You can select multiple system options/MEAP applications, 
however, you cannot select different versions of a product at the 
same time. 

  
 If the agreement screen is displayed, read the agreement. If you 
abide with the agreement, press [Accept]. 

 7 Check the Installation Result screen. 

   

 When the installation of the system options is completed, the 
message <Enabled After Restart> appears on the Installation 
Result screen. Restart the machine to activate the function. 

  

 Depending on the installed system options/MEAP applications, 
you can download the manuals for system options/MEAP 
applications from your computer by accessing the URL for 
the manual download site displayed on the Installation Result 
screen. (See “Downloading the Manuals and Related Software,” 
on p. 79.) 

  Using the Remote UI to 

Install (Delivery)
 You can install system options/MEAP applications in the 
machine using the Remote UI. 

 1 From the portal page of the Remote UI, click 
[Settings/Registration] → [License/Other] → 
[Register/Update Software]. 

   

 2 Click [Delivered Installation]. 

   

 3 Enter the license access number → click [Next].  

   

 Once the license access number is confirmed after contacting 
the delivery server, information for the system options/MEAP 
applications you can install are displayed. 

  

 If an incorrect license access number is entered, an error page 
appears. 



76

U
si

n
g

 t
h

e
 S

ys
te

m
 O

p
ti

o
n

s/
M

E
A

P
 A

p
p

lic
a

ti
o

n
s

3

  

   Installing by Not 
Connecting This Machine to 
an Outside Network 

 This section describes the procedure for installing 
system options/MEAP applications without 
connecting the machine to an external network. 

 When installing system options/MEAP applications 
without connecting the machine to an external 
network, first obtain the license key or license file. 

 ●  License key: 
 Obtain a license key if you want to install a system option 
using the touch panel display. 

 ●  License File: 
 Obtain a license file if you want to install a system option/
MEAP application using the Remote UI. 

  

•  Prepare the License Access Number certificate that was included 
in the package. 

•  If your MEAP application does not come with a License Access 
Number, your license file will be provided by your MEAP 
Application provider. The license key and license file described 
in this section are not required. For more information, see the 
manual provided with each MEAP application. 

 1 Check the management number you need to obtain 
the license key or the license file. 

 To obtain the license key or the license file, the following 
management number is required. 

•  License Access Number: Check the license access number 
certificate. 

•  Device Serial Number: Check and note the serial number 
which is displayed at the bottom left of the screen when you 
press [Counter Check] on the machine. 

 2 Access http://www.canon.com/lms/license/. 

 3 Follow the instructions on the screen and obtain the 
license key/license file. 

 After you obtain the license key or license file, install system 
options/MEAP applications in the machine using one of the 
following procedures below. 

•  See “Installing a System Option Using the Touch Panel Display,” 
on p. 77. 

•  See “Installing the System Options Using the Remote UI 
(Manual),” on p. 77. 

•  See “Installing the MEAP Applications Using the Remote UI 
(Manual),” on p. 78. 

  

•  If you install multiple system options in the machine, using the 
Remote UI is highly recommended. 

•  When you install MEAP applications, you must start the application 
before using the MEAP application. (See “Starting the MEAP 
Applications,” on p. 79.) 

 4 Select the system options and MEAP applications 
→ click [Start Installation].  

   

 Operations after installation: 
 Start: Starts the installed MEAP application. 
 Stop: Stops the installed MEAP application. 

  

 If [Stop] is selected when installing MEAP applications, you must 
start the application before using the MEAP application. (See 
“Starting the MEAP Applications,” on p. 79.) 

  

 If the agreement screen is displayed, read the agreement. If you 
abide with the agreement, click [Accept]. 

 5 Check the Installation Result screen. 

   

 When the installation of the system options is completed, the 
message <Restart the device.> appears. Restart the machine to 
activate the function. 
 To return to the Delivered Installation screen, click [To Delivered 
Installation]. 

  

 Depending on the installed system options/MEAP applications, 
you can download the manuals for system options/MEAP 
applications from your computer by accessing the URL for 
the manual download site displayed on the Installation Result 
screen. (See “Downloading the Manuals and Related Software,” 
on p. 79.) 
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  Installing the System 

Options Using the Remote UI 

(Manual)
 You can install system options in the machine using the 
Remote UI. 

 1 From the portal page of the Remote UI, click 
[Settings/Registration] → [License/Other] → 
[Register/Update Software].  

   

 2 Click [Manual Installation]. 

   

 3 Click [Browse] → select the license file to install → 
click [Next]. 

   

 License File: A file with the ‘lic’ extension. 

  

•  The file path for the application file is not used in the above 
procedure. 

•  You can also specify the file path by entering it directly. 

 4 Check the contents that will be installed on the 
confirmation screen → click [Install]. 

  Installing a System Option 

Using the Touch Panel 

Display
 You can register a license key and install a system option in the 
machine using the touch panel display. 

 1 Press (Settings/Registration)→ [Management 
Settings] → [License/Other] → [Register License]. 

 2 Enter the license key using  -  (numeric keys). 

   

 Details of each item are shown below. 
   : Press to move the position of the cursor. 
 [Backspace]: Press when you enter an incorrect number. The last 
number entered is deleted, enabling you to enter the correct 
number. 
 If the message <The value of the license key is incorrect. Check 
the license key.> appears, press [OK] → enter the correct license 
key. 
 If the message <The feature required for installation is not 
present.> is displayed, you cannot register the license key. Press 
[OK] → cancel the registration. 

 3 Press [Start] → [OK]. 

 The registered function becomes available after you restart the 
machine. 
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 3 Click [Browse] → select the license file and the 
application file to install → click [Next].  

   

 License File: A file with the ‘lic’ extension. 
 Application File: A file with the ‘jar’ extension. 

  

•  You cannot install only license files. 

•  When installing a MEAP application, make sure you specify the 
license file. You cannot install the application without specifying 
the license file. 

  

  

 You can also specify the file path by entering it directly. 

 4 Confirm the information displayed on the install 
confirmation page → click [Yes]. 

   

 Depending on the MEAP application, a software license 
agreement screen may be displayed. Confirm the information 
displayed on the screen → click [OK]. 
 If you are installing a new MEAP application, the following 
information is displayed on the screen. 

•  Application Information 

•  License Information 
 The following information is displayed when you overwrite a 
MEAP application. 

•  Current Application Information 

•  Application Information after Overwrite 
 Installation will start after the message <Installing... Please wait.> 
appears again. After the installation, click [To Manual Installation] 
to display the Manual Installation screen. 

  

 To use the installed MEAP application, you must start the MEAP 
application. (See “Starting the MEAP Applications,” on p. 79.) 

  Installing the MEAP 

Applications Using the 

Remote UI (Manual)
 You can install MEAP applications in the machine using the 
Remote UI. 

  

•  The maximum number of MEAP applications that can be 
installed is 19. 

•  The maximum amount of hard disk space allocated to install 
MEAP applications is 1 GB. 

•  There may be other system requirements for installation, 
depending on the MEAP application. For more information, see 
the manual provided with each MEAP application. 

 1 From the portal page of the Remote UI, click 
[Settings/Registration] → [License/Other] → 
[Register/Update Software]. 

   

 2 Click [Manual Installation]. 
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   Downloading the 
Manuals and Related 
Software 

 Depending on the installed system options/
MEAP applications, you can download manuals 
and related software for system options/MEAP 
applications from the following URL. 

 http://canon.com/fau/downloads 

  

•  Prepare the License Access Number certificate that was included 
in the package. 

•  If you cannot find a manual to download, see the function 
descriptions in the e-Manual included with this machine. 

•  If you installed from the Remote UI, you can jump to the above 
URL from the link displayed on the Installation Result screen. If 
you do so, the license access number is entered automatically. 

 1 Start the Web browser on your computer. 

 2 Enter the URL in [Address]. 

 3 After entering the license access number, follow the 
instructions on the screen to download the manuals 
and related software. 

 If software is downloaded, refer to the manual of that software 
to install. 

  

   Starting the MEAP 
Applications 

 This section describes how to start the installed 
MEAP application from the SMS screen. 

  

 For more information on SMS, see e-Manual > MEAP. 

 1 From the top page of the SMS, click [MEAP 
Application Management]. 

   

 2 Click [Start] for the application to start. 
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 Managing Register/Update 
Software 

 Using the Register/Update Software function, you can check the installation log for system options/MEAP applications and 
perform communication tests with the delivery server. You can use this function from both the touch panel display and the 
computer (Remote UI). 

 

・Display installation log

・Perform communication test

・Display installation log

・Perform communication test

This Machine Delivery Server

Access from the Touch Panel Display

Access from the Remote UI

 

 Managing by Using the Touch Panel 
Display (p. 81) 

 Managing by Using the Remote UI (p. 83) 
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   Managing by Using the 
Touch Panel Display 

 You can display the installation logs and test 
communication using the touch panel display. 

  

 Multiple users cannot use the Register/Update Software function 
at the same time. 

Displaying the Installation/

Update Log Using the Touch 

Panel Display
 You can check the installation logs of the system options/
MEAP applications and the update log of the firmware. 

 1 Press (Settings/Registration)→ [Management 
Settings] → [License/Other] → [Register/Update 
Software]. 

 2 Press [Software Management Settings]. 

   

 3 Press [Select Log Display]. 

   

 4 Press [Display Update Logs]. 

   

 The installation logs of the system options and MEAP 
applications are displayed. 
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  Using the Touch Panel 

Display
 You can check whether the machine can properly 
communicate with the delivery server. 

 1 Press (Settings/Registration)→ [Management 
Settings] → [License/Other] → [Register/Update 
Software]. 

 2 Press [Software Management Settings]. 

   

 3 Press [Test Communication]. 

   

 4 Press [Yes]. 

   

 Contents for the test are downloaded from the delivery server. 
When the communication test is completed, the communication 
test result screen is displayed. 

   

  

 If ‘Failed’ is displayed on the communication test result screen, 
check that the network cable is connected and that the network 
settings are correct. If the problem is not resolved, contact your 
local authorized Canon dealer. 
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 2 Click [Display Logs/Communication Test]. 

   

 3 From the Log View drop-down list, select [Update 
Logs] → click [Switch]. 

   

 The installation logs of the system options and MEAP 
applications are displayed. 

  

   Managing by Using the 
Remote UI 

 You can display the installation logs and test 
communication using the Remote UI. 

  

•  Multiple users cannot use the Register/Update Software function 
at the same time. 

•  If another user is logged in to SMS (Service Management 
Service), you cannot use the Register/Update Software function 
from the Remote UI. 

•  If you perform one of the following operations, you cannot use 
“Register/Update Software” from the Remote UI for a certain 
period of time: 

•  If you close the Web browser without pressing [Portal] or [Log 
Out], when the Remote Login Service for SMS is set. 

•  If you close the Web browser without pressing [Portal], when 
the Remote Login Service for SMS is not set. 

•  If you close the Web browser without pressing [Log Out from 
SMS], [To Remote UI], or [Log Out] for SMS. 

Displaying the Installation/

Update Log Using the 

Remote UI
 You can check the installation logs of the system options/
MEAP applications and the update log of the firmware. 

 1 From the portal page of the Remote UI, click 
[Settings/Registration] → [License/Other] → 
[Register/Update Software]. 
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  Using the Remote UI
 You can check whether the machine can properly 
communicate with the delivery server. 

 1 From the portal page of the Remote UI, click 
[Settings/Registration] → [License/Other] → 
[Register/Update Software]. 

   

 2 Click [Display Logs/Communication Test] → 
[Communication Test]. 

   

 When the confirmation dialog is displayed, click [Yes]. Contents 
for the test are downloaded from the delivery server. When the 
communication test is completed, the communication test 
result screen is displayed. 

   

  

 If ‘Failed’ is displayed on the communication test result screen, 
check that the network cable is connected and that the network 
settings are correct. If the problem is not resolved, contact your 
local authorized Canon dealer. 
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 Updating the Firmware 

 You can update the firmware of the machine to the most recent version using the “Register/Update Software.” 

 

Obtaining the 
Firmware

Updating the 
Firmware

Registering the Firmware from the Remote UI

This Machine

・Access the Remote UI

・Update firmware

 

  

 Using the Remote UI to Update 
(Delivery) (p. 86) 
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   Using the Remote UI to 
Update (Delivery) 

 You can update the firmware of the machine from 
the Remote UI. 

  

•  To perform this procedure, you need the firmware data that is 
distributed separately.  

•  Multiple users cannot use the Register/Update Software function 
at the same time. 

•  If another user is logged in to SMS (Service Management 
Service), you cannot use the Register/Update Software function 
from the Remote UI. 

•  If you perform one of the following operations, you cannot use 
“Register/Update Software” from the Remote UI for a certain 
period of time: 

•  If you close the Web browser without pressing [Portal] or [Log 
Out], when the Remote Login Service for SMS is set. 

•  If you close the Web browser without pressing [Portal], when 
the Remote Login Service for SMS is not set. 

•  If you close the Web browser without pressing [Log Out from 
SMS], [To Remote UI], or [Log Out] for SMS. 

  

 1 From the portal page of the Remote UI, click 
[Settings/Registration] → [License/Other] → 
[Register/Update Software]. 

   

 2 Click [Manual Update]. 

   

 3 Click [Browse] → select the firmware to use for the 
update → click [Next]. 

   

 4 Confirm the information displayed on the update 
confirmation page → click [Yes]. 

   

 The machine now has the latest firmware applied. When the 
message <The firmware is updated. Restart the device.> appears, 
restart the machine. 
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